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Stresses
Chapter 1

Stresses are quantities to describe the intensity of force in a body (either solid or fluid).  Its unit is force per unit area 
(i.e., N/m2 in SI).  It is position dependent.
� Imagine that your arms are pulled by your friends with two forces of the same magnitude but opposite directions.  
What are the stresses in your arms?  Assuming the magnitude of the forces is 100 N and the cross-sectional area of your 
arms is 100 cm2, then you may answer, "the stresses are 1 N/cm2 . everywhere in my arms."  This case is simple and the 
answer is good enough.  For an one-dimensional case like this, the stress �  may be easily defined as 

 
� =

P

A
 where P is the applied force and A is the cross sectional area.
� In general 3D cases, things are much more complicated.  Now, imagine that you are buried in the soil by your friends, 
and your head is 100 m deep below the ground surface.  How do you describe the force intensity (i.e., stress) on your 
head?
� If the soil is replaced by still water, than the answer would be much simpler.  The magnitude of the pressure (stress) 
on the top of your head would be the same as the pressure on your cheeks, and the direction of the pressure would 
always be perpendicular to the surface where the pressure applies.  You've learned these concepts in your high school.  
And you've learned that the magnitude of the pressure is  � = �gh, where � is the mass density of the water, g is the 
gravitational acceleration, and h is the depth (100 meters in this case).  In general, to describe the force intensity at a 
certain position in water, we place an infinitesimally small body at that position, and measure the force per unit surface 
area on that body.
� In the soil (which is a solid material rather than water), the situation is much more complicated.  First, the magnitude 
of the pressure on the top of your head may not be the same as that on your cheeks.  Second, the direction of pressure 
is not necessarily perpendicular to the surface where the pressure applies.  However, the above definition of stresses for 
water still holds.  Let me restate as follows:

The stress at a certain position in a solid material is defined as the force per unit surface area on an 
infinitesimally small body placed at that position.

Note that, the infinitesimally small body could be any shapes, and if we know the stresses on a certain shape of small 
body, we can infer the stresses on other shapes.  We usually take a small cube to describe the stresses.
� This chapter will guide you to learn the concepts of stresses.
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1.1-1  Introduction

Stress Components
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Section 1.1

[1] Consider a cantilever beam made of an alloy steel and of dimension 10 mm x 20 mm x 100 mm [2], which is fixed 
at one end [3] and subjected to a force applied on the other end [4].  The force is in positive X-direction and has a 
magnitude of 10,000 N.  Note that, we've used a reference coordinate system as shown in [5].
� In theory, the stress is uniform over the body; i.e., every point in the beam has the same stress.  How do we 
describe this stress?  Can we simply say, the stress is 50 MPa, which is calculated by

10,000 N
10 mm ×  20 mm

= 50 MPa?
 

For a simple case like this, that may be adequate.  In order to apply to more general cases, we need to say something 
more, specifically, what is the direction of the stress?  What is the surface on which the stress acts?

 X

 Y

 Z

[4] A force of 10,000 N 
applies at this end.  The 

force distributes 
uniformly over the end 

face.  

[2] The beam is made of an alloy 
steel and of 100 mm long and has a 
cross section of 10 mm x 20 mm.

[3] The beam is 
fixed at this end.

 10,000 N

[5] To describe the force and 
stresses, we use a reference 

coordinate system XYZ.



[10] X-face.
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[11] Y-face.

[12] Z-face.

[13] Negative-X-face 
(opposite of the X-face).

 � XY

 � XZ
 � XX

[15] The 
  
�
p

X
 (force per 

unit area on X-face) can 
be decomposed into  � XX

, 

 � XY
, and  � XZ

. 

[6] Definition of Stress
The stress at a certain point can be defined as the 
force per unit area acting on the boundary surfaces of an 
infinitesimally small body centered at that point [7].  The 
stress values may be different at different locations of 
the boundary surfaces.  The small body can be any 
shape.  However, for the purpose of describing the 
stress, we usually use a small cube [8] of which each 
edge is parallel to a coordinate axis.

[8] We usually use a small 
cube for the purpose of 

describing the stress.

[7] The stress at a 
certain point can 
be defined as the 

force per unit area 
on the boundary 

surfaces of an 
infinitesimally 
small body 

centered at that 
point.

 Y

 Z
 X

 Y

 Z
 X

 Y

 Z
 X

 � ZZ

 �YY

 �YX

 �YZ

 � ZY

 � ZX

[16] The   
�
p

Y
 (force 

per unit area on Y-
face) can be 

decomposed into 

 �YY
,  �YX

, and  �YZ
. 

[17] The 
  
�
p

Z
 (force 

per unit area on Z-
face) can be 

decomposed into 

 � ZZ
, 
 � ZX

, and 
 � ZY

. 

[9] X-Face, Y-Face, and Z-Face
Each of the six faces of the cube can be assigned an 
identifier as X-face, Y-face, Z-face,  negative-X-face,  
negative-Y-face, and negative-Z-face, respectively 
[10-13].

[14] Stress Components
Let   
�
p

X
 be the force per unit area acting on the X-face.  

In general,   
�
p

X
 may not be normal or parallel to the X-

face.  We may decompose   
�
p

X
 into X-, Y-, and Z-

component, and denote 
 � XX

, 
 � XY

, and 
 � XZ

 respectively 
[15].  Note that, the first subscript (X) is used to 
indicate the face on which the stress components 
act, while the second subscript (X, Y, or Z) is used to 
indicate the direction of the stress components.  
Also note that,  � XX

 is normal to the face, while  � XY
, 

and  � XZ are parallel to the face.  Therefore,  � XX  is 
called a normal stress, while  � XY

, and  � XZ
 are called 

shear stresses.  In Mechanics of Materials, we 
usually use the symbol �  for a normal stress and �  for 
a shear stress.
� Similarly, let   

�
p

Y  be the force per unit area acting 
on the Y-face and we may decompose   

�
p

Y
 into a 

normal component ( �YY
), and two shear components 

( �YX
 and  �YZ

) [16].  Also, let   
�
p

Z
 be the force per unit 

area acting on the Z-face and we may decompose   
�
p

Z
 

into a normal component ( � ZZ ), and two shear 
components ( � ZX

 and  � ZY
) [17].  Organized in a matrix 

form, these stress components may be written as

�

 

�{ } =
�

XX
�

XY
�

XZ

�
YX

�
YY

�
YZ

�
ZX

�
ZY

�
ZZ

�

�

�
�
�

�

�

�
�
�
� (1)



[18] Stress Components on Other Faces
It can be proven that the stress components on the 
negative-X-face, negative-Y-face, and negative-Z-face can 
be derived from the 9 stress components in Eq. (1).  For 
example, on the negative-X-face, the stress components 
have exactly the same stress values as those on the X-
face but with opposite directions [19].  Similarly, the 
stress components on the negative-Y-face have the same 
stress values as those on the Y-face but with opposite 
directions [20], and the stress components on the 
negative-Z-face have the same stress values as those on 
the Y-face but with opposite directions [21].
� The proof can be done by taking the cube as free 
body and applying the force equilibria in X, Y, and Z 
directions respectively.
� On an arbitrary face (which may not be parallel or 
perpendicular to an axis), the stress components can be 
calculated from those on X-face, Y-face, and Z-face.  We'll 
show that this can be done using a Mohr's circles 
(Section 10.1).
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 Y

 Z
 X

 � XX

 � ZZ

 �YY

 � XY

 � XZ

 � ZY

 � ZX

 �YX
 �YZ

[19] The stress 
components acting on 

the negative-X-face 
have exactly the same 
stress values as those 

on the X-face but 
with opposite 

directions. 

[20] The stress 
components acting on 

the negative-Y-face 
have exactly the same 
stress values as those 
on the Y-face but with 
opposite directions. 

[21] The stress 
components acting on 

the negative-Z-face 
have exactly the same 
stress values as those 
on the Z-face but with 

opposite directions. 

[22] Symmetry of Shear Stresses
It also can be proven that the shear stresses are 
symmetric, i.e.,

�  � XY
= �

YX
,    �YZ

= �
ZY

,    � ZX
= �

XZ
� (2)

The proof can be done by taking the cube as free body 
and applying the moment equilibria in X, Y, and Z 
directions respectively.

[23] Stress Components
We now conclude that 3 normal stress components and 
3 shear stress components are needed to describe the 
stress state at a certain point.  We usually write them 
as follows

�
 
�{ } = �

X
�

Y
�

Z
�

XY
�

YZ
�

ZX{ }� (3)

Note that, for more concise, we use  � X
 in place of  � XX

, 

 �Y
 in place of  �YY

, and  � Z
 in place of  � ZZ

.
� The purpose of this section is to familiarize the 6 
stress components in Eq. (3).  The stress field in this 
section is uniform over the entire body.  In the next 
section, we'll explore a nonuniform stress field.
� Another purpose of this section is to familiarize the 
SolidWorks Simulation user interface.
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1.1-2  Launch SolidWorks and Create a New Part

About the Text Boxes
1.  Within each subsection (e.g., 1.1-2), text boxes are ordered with numbers, each of which is enclosed by a pair of 
square brackets (e.g., [1]).  When you read the contents in a subsection, please follow the order of the text boxes.
2.  The text box numbers also serve as reference numbers when referred from other text.  In the same subsection, we 
simply refer to a text box by its number (e.g., [1]).  From other subsections, we refer to a text box by its subsection 
identifier and the text box number (e.g., 1.1-2[1]).
3.  A text box is either round-cornered (e.g., [1, 3, 5]) or sharp-cornered (e.g., [2, 4]).  A round-cornered box indicates 
that mouse or keyboard actions are needed in that step.  A sharp-cornered box is used for commentary only: no 
mouse or keyboard actions are needed in that step.

SolidWorks Terms
In this book, terms used in the SolidWorks are boldfaced (e.g., Part in [4, 5]).

[3] Click New to create 
a new document.

[4] Part is selected 
by default.

[5] Click OK to 
create a Part 

document.

[1] Launch 
SolidWorks.[2] User Interface.
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1.1-3  Set Up Unit System 
[1] Click Options.

[2] Click 
Document 

Properties tab.

[3] Select 
Units.

[4] Select MMGS 
as unit system.

[6] Click OK.

[5] Select None 
(no decimal places).

[7] The unit system 
shows here.  You 

also can change the 
unit system by 
clicking here.
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1.1-4  Create a Geometric Model

[2] In the Sketch Toolbar, 
select Center Rectangle.

[1] In the Features Tree 
(on the left of the user 

interface), right-click Right 
plane and select Sketch 

from the Context Menu.

[3] Draw a rectangle 
centered at the origin (the 

sizes are arbitrary for now).

[4] In the Sketch Toolbar, 
click Smart Dimension.

[5] Specify dimensions 
(10 mm and 20 mm) 

like this.
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[6] In the Features 
Toolbar, click Extruded 

Boss/Base.

[8] Click OK.

[7] In the Property Box, 
type 100 (mm) for Depth.

[9] The finished 
geometric model.



1.1-5  Load SolidWorks Simulation

[1] If SolidWorks Simulation is already 
loaded (i.e., if Simulation Toolbar is 

available), skip this step.  Otherwise, in the 
Office Products Toolbar, click to load the 

Simulation.
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[5] You may also check here so that the 
Simulation will be loaded 

automatically each time you start up 
SolidWorks.  In this book, we assume 

that you set up this way so that the 
Simulation is loaded automatically 

each time you start up SolidWorks.

[2] The Simulation Toolbar 
becomes available.

[3] Another way to load the 
Simulation is selecting 

Tools>Add-Ins... from Pull-
Down Menus.

[4] And then select 
SolidWorks Simulation.



1.1-6  Create a Static Structural Study 

[3] Type Elongation 
for study Name.
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[4] Click OK.

[2] By default, Static 
(static structural study) is 
selected as study Type.

[5] A tab is added 
and becomes active.

[6] A Study Tree 
appears right below the 

Features Tree.

[1] In the Simulation 
Toolbar, select Study 
Advisor>New Study.



1.1-7  Set Up Options for SolidWorks Simulation
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[1] From Pull-Down Menus, 
select 

Simulation>Options...

[2] Select Default 
Options tab.

[3] By default, 
Units is selected.

[4] Select SI.

[7] For a Static Study, by 
default, three result plots will be 
created after a successful run.  
Let's walk through these result 
plots and adjust some settings, 

which will be used for the 
entire book.

[5] Select mm for 
Length/

Displacement.

[6] Select N/mm^2 [MPa] 
for Pressure/Stress.
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[17] Click OK.

[8] Click Plot1.

[10] Make sure Nodal Stress is 
selected.  The stress values will be 

reported at Nodes (rather than at 
Elements).

[9] By default, Plot1 reports von 
Mises Stress, which will be defined in 

Eq. 10.2-1(8), page 197 (also see Eq. 
10.2-3(15), page 203).

[11] Click Plot2.

[14] Click Plot3.

[12] By default, Plot2 
reports Resultant 

Displacement, which is 
defined in Eq. 2(2), page 51.

[13] The displacement values are 
always reported at Nodes.

[15] By default, Plot3 
reports Equivalent 

Strain (Eq. 10.2-3(16), 
page 203).

[16] Select Nodal Strain.  
The strain values will be 

reported at Nodes (rather than 
at Elements).

[18] The options set up here 
will be permanent unless 
you change them again.  

We'll assume these setups 
through this book.  

Specifically, make sure 
stresses and strains are 

reported at nodes [10, 16].



1.1-8  Apply Material

[1] In the Study Tree, right-
click Part1 (which is the 

geometric model we've created) 
and select Apply/Edit 

Material...
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[2] By default, Alloy 
Steel is selected.

[4] Click 
Apply.

[5] Click 
Close.

[3] Elastic modulus, 
Poisson's ratio, and 

shear modulus are the 
three most important 

material properties in this 
book.  They will be 

defined in Sections 4.1 
and 4.2.



1.1-9  Apply Support

[1] In the Study Tree, right-
click Fixtures and select 

Fixed Geometry...

[2] Click this face.
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[3] The selected 
face appears here.

[6] A fixed support is added 
to the Study Tree.

[4] Click 
OK.

[5] This face is 
fixed.



1.1-10  Apply Load

[2] Click this 
face.

[3] The face 
appears here.
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[6] Click 
OK.

[4] Type 10000 (N).

[1] In the Study Tree, right-
click External Loads and 

select Force...

[5] Check Reverse 
direction.

[7] A force of 10,000 N 
applies uniformly on this 

face.

[8] A force is added to the 
Study Tree.



1.1-11  Solve the Model

[1] In the Simulation 
Toolbar, click Run.  It 

takes only a few seconds to 
solve the model.
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[2] As mentioned earlier (1.1-7), by 
default, results for Von Mises 

Stress, Resultant 
Displacement, and 

Equivalent Strain are created.  
Note that Stress1 is highlighted, 

meaning it is active and displayed in 
the Graphics Area.

[3] By default, Von Mises 
Stress is displayed.  We'll 
change to display  � X later.[5] The stress is uniform over the entire body except 

the area near the fixed end, where the stresses are 
complicated and we'll explain this phenomenon in 
5.2-3[16, 17], page 102.  Let's neglect these stress 

values here for now.  In the next few steps, we'll turn 
off the max/min annotations.

[4] This is the deformed 
(elongated) shape; the deformation 
is exaggerated.  We'll turn off the 

deformed shape display later.

[6] To make the model even 
"cleaner," we'll turn off the display 

of External Loads and 
Fixtures in the next few steps.



1.1-12  View the Normal Stress  � X
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[1] Right-click Stress1 and 
select Edit Definition... 

(or simply double-click 
Stress1).

[2] Select SX: X Normal 
Stress (i.e.,  � X

) for 
Component.

[3] Uncheck Deformed 
Shape.  The undeformed 
shape will be displayed.

[4] Click OK.

[5] Right-click Stress1 and 
select Chart Options...

[6] Uncheck both Show 
min annotation and 

Show max annotation.

[7] Click OK.

[8] Right-click 
Fixed-1 and select 

Hide.

[9] Right-click 
Force-1 and select 

Hide.
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[11] Remember, let's neglect the 
complicated stresses near the 

fixed end for now.

[12] Except the fixed end, the 
normal stress 

 � X
 is uniform 

(since the color is uniform). 

[10] Now, the normal 
stress in the X-direction 
(i.e.,  � X

) is displayed.  The 
unit is MPa.

[13] From the legend 
colors, the normal stress 

 � X
 is approximately 50 

MPa.  Let's use Probe to 
obtain a more accurate 

value.

[14] Right-click Stress1 
and select Probe.

[15] Click several locations 
(away from the fixed end) in 

the model to display the  
normal stress  � X

.  The normal 
stress  � X

 is indeed uniform 
and the value is 50 MPa.  Click 
OK in the Property Box to 
dismiss the Probe Result.
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1.1-13  View Other Stress Components

[2] As an exercise, we leave it 
to you to explore other stress 

components.

[1] Right-click Stress1 and 
select Edit Definition... 
(or double-click Stress1). [3] These are six stress 

components ( � X
,  �Y

,  � Z
, 

 � XY
,  � XZ

,  �YZ
).  Note that, 

YZ Plane is the same as 
X-face, and XZ Plane is 

the same as Y-face.

Stress 
Component Stress Value

50 Mpa

0

0

0

0

0

 � X

 �Y

 � XY

 � XZ

 �YZ

 � Z

[4] Write down each stress 
component value.  The results 

should be like this.  In this 
example, all stress components 
are essentially zeros, except 

 � X
 

(which is 50 MPa)

 Y

 Z
 X

 50 MPa

 50 MPa

[5] The stress state of any point in the 
cantilever beam can be represented like 
this.  In the next exercise, we'll explore 

a case in which a shear stress 
component is non-zero and the stress 

states are non-uniform.
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1.1-14  Save the Document and Exit SolidWorks

[1] Click Save to save the document with the name 
Cantilever.  Two files are created in your working folder: 

Cantilever.SLDPRT and Cantilever-
Elongation.CWR; the former is the main project file, while 
the later stores the result data generated by a finite element 

solver.  Other files, if any, are not relevant; they can be deleted.

[2] From the Pull-Down 
Menus, select File>Exit 

to exit SolidWorks.




